Evaluating the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 16-Bit Simultaneous Sampling, 8-/6-/4-Channel, SAR ADC

FEATURES
Full-featured evaluation board for the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4
On-board power supplies
Standalone capability
System demonstration platform (SDP) compatible (EVAL-SDP-CB1Z)
PC software for control and data analysis (download from the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 product pages)

EVALUATION KIT CONTENTS
EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board
Evaluation software CD for the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4
Mains power supply adapter
Screw/nut kit

ADDITIONAL EQUIPMENT NEEDED
EVAL-SDP-CB1Z system demonstration platform
PC running Windows® Vista or Windows 7 with a USB 2.0 port
Signal source
SMB and USB cables

ONLINE RESOURCES
Documents Needed
AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 data sheets
EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ user guide

Required Software
AD7606 evaluation software

Design and Integration Files
Schematics, layout files, bill of materials

EVALUATION BOARD DESCRIPTION
The EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ is a full-featured evaluation board that allows users to easily evaluate the features of the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 analog-to-digital converters (ADCs). The evaluation board can be controlled by the EVAL-SDP-CB1Z SDP board via a 120-way SDP connector (J2). The SDP board allows the evaluation board to be controlled through the USB port of a PC using the AD7606 evaluation software. The software is available for download from the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 product pages or from the installer CD included in the evaluation board kit.

On-board components include an ADP7104ARDZ-5.0 5 V, low noise low dropout regulator (LDO) and an ADR421 high precision, band gap voltage reference.

Full data on the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 is available in the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 data sheets, which should be consulted in conjunction with this user guide when using the evaluation board. Full details on the EVAL-SDP-CB1Z are available at the SDP board product page.
TABLE OF CONTENTS

Features .............................................................................................. 1
Evaluation Kit Contents ..................................................................... 4
Additional Equipment Needed ....................................................... 1
Online Resources .............................................................................. 1
Evaluation Board Description ......................................................... 1
Revision History ............................................................................... 2
Quick Start Guide ............................................................................. 3
Evaluation Board Hardware ............................................................ 4
Device Description ....................................................................... 4
Hardware Link Options .................................................................. 4
Sockets/Connectors ...................................................................... 4
Power Supplies ............................................................................. 4
Channel Input ............................................................................... 4
Evaluation Board Software ............................................................ 6
Software Installation ..................................................................... 6
Description of Main Window ....................................................... 8
Waveform Capture Tab .............................................................. 10
Histogram Tab ............................................................................... 11
AC Testing—FFT Capture ........................................................ 12
Summary Tab .............................................................................. 13
Saving Files .................................................................................. 14
Opening Files .............................................................................. 14

REVISION HISTORY

9/2016—Rev. 0 to Rev. A
Added EVAL-AD7605-4SDZ and AD7605-4. Throughout
Changes to Quick Start Guide Section ........................................ 3
Changes to Power Supplies Section, Channel Input Section,
EVAL-AD7606SDZ Section, EVAL-AD7607SDZ Section,
EVAL-AD7608SDZ Section, EVAL-AD7606-6SDZ Section,
and Table 2 ................................................................. 4
Changes to EVAL-AD7606-4SDZ Section and Table 3 ............ 5
Changes to Installing the Evaluation Software Section,
Figure 2 Caption, Figure 3 Caption, Figure 4 Caption, and
Figure 5 Caption ................................................................. 6
Changes to Installing the SDP Board Drivers Section,
Figure 6 Caption, Figure 7 Caption, Figure 8 Caption, and
Figure 9 Caption ................................................................. 7
Changes to the Description of Main Window Section,
Sampling Rate Section, and Range Section ......................... 8
Added Selecting Active Channels Section ............................... 8
Changes to Taking Samples Section ......................................... 9
Changes to Waveform Capture Tab Section ............................. 10
Changes to Histogram Tab Section ............................................ 11
Changes to AC Testing—FFT Capture Section .............. 12
Changes to Summary Tab Section ........................................... 13
Changes to Saving Files Section and Changing Files Section .... 14

8/2015—Revision 0: Initial Version
QUICK START GUIDE

Follow these steps to quickly evaluate the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 ADCs. For detailed instructions, see the subsequent sections.

1. Install the evaluation software from the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 product pages or from the CD included in the evaluation kit. Ensure the EVAL-SDP-CB1Z SDP board is disconnected from the USB port of the PC while installing the software. The PC may need to be restarted after the installation.

2. Ensure the various link options are configured as outlined in Table 3.

3. Connect the EVAL-SDP-CB1Z SDP board to the evaluation board as shown in Figure 1. Screw the EVAL-SDP-CB1Z SDP board and EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board together using the enclosed nylon screw/nut kit to ensure the boards connect firmly together.

4. Connect a 5 V power supply to the J1 connector and ensure Link LK1 is in Position A.

5. Connect the EVAL-SDP-CB1Z SDP board to the PC via the USB cable. Choose to automatically search for the drivers for the SDP board if prompted by the operating system.

6. Launch the evaluation software from the Analog Devices subfolder in the Programs menu.

7. Connect an input signal via the V1 to V8 terminal blocks.

Figure 1. Evaluation Board (Left) Connected to the SDP Board (Right)
EVALUATION BOARD HARDWARE

DEVICE DESCRIPTION

The AD7605-4, AD7606/AD7606-6/AD7606-4, AD7607, and AD7608 are 16-bit, 8-/6-/4-channel, simultaneous sampling successive approximation ADCs. The devices operate from a single 2.7 V to 5.25 V power supply and feature throughput rates of up to 200 kSPS. The devices have on-board 1 MΩ input buffers for direct connection from the user sensor outputs to the ADC.

HARDWARE LINK OPTIONS

The functions of the link options are described in Table 3. The default setup is configured to operate the evaluation board with the main power supply or 9 V adapter and to interface to the SDP board.

SOCKETS/CONNECTORS

The connectors and sockets on the evaluation board are outlined in Table 1.

Table 1. On-Board Connectors

<table>
<thead>
<tr>
<th>Connector</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1</td>
<td>7 V to 9 V, 2.0 mm dc jack connector</td>
</tr>
<tr>
<td>J2</td>
<td>120-way connector for EVAL-SDP-CB1Z interface</td>
</tr>
<tr>
<td>J3</td>
<td>External power terminal block, 7 V to 9 V dc input</td>
</tr>
<tr>
<td>V1 to V8</td>
<td>Analog input SMB connectors</td>
</tr>
</tbody>
</table>

The default interface to this evaluation board is via the 120-way connector, which connects the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 evaluation board to the EVAL-SDP-CB1Z SDP board.

POWER SUPPLIES

Before applying power and signals to the evaluation board, ensure all link positions are set according to the required operating mode. See Table 3 for the complete list of link options.

The AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 evaluation board is supplied with a wall-mountable switching power supply that provides 9 V dc output. Connect the supply to a 100 V to 240 V ac wall outlet at 50 Hz to 60 Hz. The output from the supply is connected to a 2.0 mm inner diameter jack that connects to the evaluation board at the J1 connector. The 9 V supply is connected to the on-board, 5 V linear regulator that supplies the correct bias to each of the various sections on the evaluation board and on the EVAL-SDP-CB1Z SDP board.

When using the EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board with the EVAL-SDP-CB1Z SDP board, power the evaluation board through the J1 connector.

If the EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board is used without the 9 V adapter, an external power supply in the range 7 V to 9 V must be connected to the J3 terminal block to supply the ADP7104 5 V linear regulator. Each supply is decoupled on the EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board using 10 μF tantalum and 100 nF multilayer ceramic capacitors.

Table 2. External Power Supplies Required

<table>
<thead>
<tr>
<th>Power Supply Input</th>
<th>Voltage Range (V)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1 connector</td>
<td>7 to 9</td>
<td>Default power supply option using the supplied mains power adapter</td>
</tr>
<tr>
<td>J3 terminal block</td>
<td>7 to 9</td>
<td>Alternative power supply option Requires external source</td>
</tr>
</tbody>
</table>

CHANNEL INPUT

Depending on the specific evaluation board, the external signal can be applied to various combinations of V1 to V8.

Connectors V1 to V8 allow users to connect external signals to the ADC channel inputs. The evaluation board is supplied with the connection options that are required for the specific device number that is being evaluated. The various combinations of connection options to which external signals can be applied are defined in the following sections.

EVAL-AD7606SDZ

The EVAL-AD7606SDZ evaluation board is supplied with the AD7606 mounted at U1 (see Figure 1). The AD7606 is an 8-channel data acquisition system (DAS) with a simultaneous sampling ADC. On this evaluation board external signals can be applied to the V1 to V8 terminal blocks.

EVAL-AD7607SDZ

The EVAL-AD7607SDZ evaluation board is supplied with the AD7607 mounted at U1 (see Figure 1). The AD7607 is an 8-channel DAS with a simultaneous sampling ADC. On this evaluation board external signals can be applied to the V1 to V8 terminal blocks.

EVAL-AD7608SDZ

The EVAL-AD7608SDZ evaluation board is supplied with the AD7608 mounted at U1 (see Figure 1). The AD7608 is an 8-channel DAS with a simultaneous sampling ADC. On this evaluation board external signals can be applied to the V1 to V8 terminal blocks.

EVAL-AD7606-6SDZ

The EVAL-AD7606-6SDZ evaluation board is supplied with the AD7608 mounted at U1 (see Figure 1). The AD7606-6 is a 6-channel DAS with a simultaneous sampling ADC. External signals can be applied to V1, V2, V3, V5, V6, and V7. Input Connectors V5 to V7 route to the AD7606-6 V4 to V6 input channels, respectively.
EVAL-AD7606-4SDZ

The EVAL-AD7606-4SDZ evaluation board is supplied with the AD7606-4 mounted at U1 (see Figure 1). The AD7606-4 is a 4-channel DAS with simultaneous sampling ADC. External signals can be applied to V1, V2, V5, and V6. Input Connectors V5 and V6 route to the AD7606-4 V3 and V4 input channels, respectively.

Table 3. Link Options

<table>
<thead>
<tr>
<th>Link</th>
<th>Default Position</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LK1</td>
<td>A</td>
<td>This link is used to select the power supply source for the evaluation board. In Position A, the board can be powered by the supplied wall mounted switching supply using the J1 connector. In Position B, the evaluation board must be powered by an external supply connected to the J3 terminal block.</td>
</tr>
<tr>
<td>LK2</td>
<td>Insert</td>
<td>LK2 supplies the SDP power supply from the evaluation board. The EVAL-SDP-CB1Z is powered from the ADP7104 5 V linear regulator.</td>
</tr>
<tr>
<td>LK3</td>
<td>B</td>
<td>LK3 is used to select the VDRIVE source for the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4. In Position A, the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 are supplied with 3.3 V VDRIVE. In Position B, the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 are supplied with 5 V VDRIVE. 5 V VDRIVE runs the device at 200 kSPS in serial interface mode.</td>
</tr>
<tr>
<td>SL1</td>
<td>A</td>
<td>In Position A, the CS signal is supplied from the SDP terminal, J2. In Position B, the CS SMB is selected.</td>
</tr>
<tr>
<td>SL2</td>
<td>A</td>
<td>In Position A, the SCLK signal is supplied from the SDP terminal, J2. In Position B, the SCLK SMB is selected.</td>
</tr>
<tr>
<td>SL3</td>
<td>A</td>
<td>In Position A, the STBY signal is supplied from the SDP terminal, J2. In Position B, the STBY SMB is selected.</td>
</tr>
<tr>
<td>SL4</td>
<td>A</td>
<td>In Position A, the CS signal is supplied from the SDP terminal, J2. In Position B, the CS SMB is selected.</td>
</tr>
<tr>
<td>SL5</td>
<td>A</td>
<td>In Position A, the RESET signal is supplied from the SDP terminal, J2. In Position B, the RESET SMB is selected.</td>
</tr>
<tr>
<td>SL6</td>
<td>A</td>
<td>In Position A, the CS signal is supplied from the SDP terminal, J2. In Position B, the CS SMB is selected.</td>
</tr>
<tr>
<td>SL7</td>
<td>A</td>
<td>In Position A, the CONVST signal is supplied from the SDP terminal, J2. In Position B, the CONVST SMB is selected.</td>
</tr>
</tbody>
</table>
EVALUATION BOARD SOFTWARE
SOFTWARE INSTALLATION
The EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ kit includes the evaluation software on a CD; the software is also available for download from the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 product pages.

There are two parts to the installation:
- AD7606 evaluation software installation
- EVAL-SDP-CB1Z SDP board drivers installation

Warning
The evaluation board software and drivers must be installed before connecting the EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board and SDP board to the USB port of the PC to ensure the evaluation system is correctly recognized when it is connected to the PC.

Installing the Evaluation Software
To install the AD7606 evaluation board software,

1. Insert the included evaluation software installation CD into the CD drive of a Windows-based PC, and open the contents of the CD.
2. Double-click the setup.exe file to begin the installation. By default, the software is saved to the following location: C:\Program Files\Analog Devices\AD7606\.
3. A dialog box appears asking for permission to allow the program to make changes to the PC. Click Yes to begin the installation process (see Figure 2).
4. Select a location to install the software, and then click Next (see Figure 3).
5. A license agreement appears. Read the agreement, select I accept the License Agreement, and click Next.
6. A summary of the installation appears. Click Next to continue (see Figure 4).
7. A dialog box informs the user when the evaluation software installation is complete. Click Next to proceed with the installation of the SDP drivers (see Figure 5).
8. The installation of the evaluation software completes.
Installing the SDP Board Drivers

After the AD7606 evaluation board software installation is complete, the ADI SDP Drivers Setup wizard window opens for the installation of the EVAL-SDP-CB1Z SDP board drivers.

1. The ADI SDP Drivers Setup Wizard opens. Click Next to begin the driver installation process (see Figure 6).

2. Select a destination folder for the SDP drivers and click Install (see Figure 7).

3. Click Install again to proceed with the installation (see Figure 8).

4. When the SDP drivers installation completes, click Finish (see Figure 9).

After the evaluation software installation is complete, connect the EVAL-AD7605-4SDZ/EVAL-AD7606SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board to the EVAL-SDP-CB1Z SDP board as described in the Evaluation Board Hardware section.

When first plugging in the EVAL-SDP-CB1Z SDP board via the USB cable provided, allow the Found Hardware Wizard to run. After the drivers are installed, check that the evaluation board is connected correctly by looking at the Device Manager of the PC. The Device Manager can be found by right-clicking My Computer > Manage > Device Manager from the list of System Tools.

The EVAL-SDP-CB1Z SDP board appears under ADI Development Tools, shown in Figure 10.
DESCRIPTION OF MAIN WINDOW

The following tools allow the user to control the operation of the AD7606 evaluation board software and the capturing and displaying of data from the ADC. When the software launches, the main AD7606 evaluation software window opens (see Figure 11).

The main evaluation software window, shown in Figure 11, has the following features:

- Menu bar
- Control buttons
- Configuration tab, Waveform tab, Histogram tab, FFT tab, and Summary tab

Menu Bar

The menu bar, Label 1 in Figure 11, consists of the File and Help menus.

The File menu includes the following options:

- Save Data—This option saves captured data in comma separated values (CSV) format for future analysis.
- Load Data—This option loads previously captured data in CSV format for analysis.
- Print Front Panel—This option prints the front panel.
- Save As Picture—This option saves the currently displayed graph of data as an image in JPEG file format.
- Exit—This option exits the program.

The Help menu includes the following option:

- Analog.com—This option links to the Analog Devices, Inc., website.

Control Buttons, Drop-Down Boxes, and Indicators

The Configuration, Waveform, Histogram, FFT, and Summary tabs control which tab is displayed. In each of these tabs, device configuration and data analysis results can be set and viewed, respectively.

Configuration Tab

The configuration tab controls to configure the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4. Available controls include the sampling rate, oversampling, range, and convert start pulse width.

Sampling Rate

Use the Sampling Rate field (Label 3 in Figure 11) to increase the rate of convert start pulses to the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4. The control accepts values from 769 Hz to 200,000 Hz on the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4, and up to 300,000 Hz on the AD7605-4. If oversampling is enabled, the maximum limit of sampling is decreased.

The EVAL-AD7606SDZ/EVAL-AD7606-6SDZ/EVAL-AD7606-4SDZ/EVAL-AD7607SDZ/EVAL-AD7608SDZ evaluation board can run with sampling rates (or sampling frequencies) up to 200 kSPS. The EVAL-AD7605-4SDZ can run with sampling rates up to 300 kSPS. Enter the required sampling rate in the Sampling Rate field (see Figure 11).

Oversampling

The Oversample Mode drop-down menu (Label 4 in Figure 11) enables and disables oversampling and chooses from rates of oversample by 2, 4, 8, 16, 32, and 64. See the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 data sheets for more information about the digital filter profile. The maximum output data rate of the AD7606/AD7606-6/AD7606-4, AD7607, AD7608, and AD7605-4 is limited by the selected oversampling rate.

Oversampling is not available on the AD7605-4.

Range

The 5V / 10 V Range drop-down menu (Label 5 in Figure 11) selects the range to be used by the software, and alters the signal analysis calculations for the Histogram, Waveform, and FFT tabs. This drop-down menu does not change the actual range of the ADC, which is determined by the state of the RANGE pin.

Ensure the range selected in the 5V / 10 V Range drop-down menu matches the hardware configuration set by the R1 and R2 resistors. Failing to select the correct range can lead to inaccurate calculations of the graphs and results displayed on the Histogram, Waveform, FFT, and Summary tabs.

Convst Pulse Width

The Cvnt Pulse Width control (Label 6 in Figure 11) varies the convert start pulse width and is set to 50 ns by default.

Samples

The user can select the number of samples captured from the # Samples drop-down menu (Label 7 in Figure 11). The default number of samples is 4096 but the number of samples can be changed by the user.

Selecting Active Channels

The ADC 1 ON/ADC 1 OFF to ADC 8 ON/ADC 8 OFF buttons allows the user to select the ADC channels from which the software captures samples. Click the appropriate ADC 1 ADC 1 OFF to ADC 8 OFF button until the button displays ON.

For example, to turn on ADC Channel 2, click the ADC 2 OFF button to change the label to ADC 2 ON, indicating data can be captured from ADC Channel 2 when capturing is initiated. Only ADC Channel 1 is selected by default.
Taking Samples

To initiate a conversion and capture the sample data, click the Sample button or the Continuous button. Both the Sample and the Continuous buttons are located at the top of the window (Label 8 in Figure 11).

When the Sample button is clicked, the software instructs the EVAL-SDP-CB1Z board to take the required number of samples at the required sampling rate from the evaluation board. Once the required number of samples are captured, the capturing process stops and the data displayed in the Waveform, Histogram, FFT, or Summary tab updates.

If the Continuous button is clicked, the label on the button changes to Stop, and the software repeats the capture of the selected number of samples indefinitely until the user clicks Stop. While the software is in the continuous capture mode, the data in the Waveform, Histogram, FFT, or Summary tab is also continuously updated.

No data appears on the screen if no active channels are selected. See the Selecting Active Channels section for details on how to select active channels.

![Figure 11. AD7606 Evaluation Software Main Window](image-url)
WAVEFORM CAPTURE TAB

The Waveform tab, shown in Figure 13, is used for waveform capture.

The waveform analysis reports the amplitudes recorded from the captured signal as well as the fundamental frequency of the signal tone. The analysis report is generated for the ADC channel selected via the ADC 1 ON/ADC 1 OFF to ADC 8 ON/ADC 8 OFF buttons (Label 1 in Figure 13).

At the bottom right of the graph are the zoom options. These allow the user to zoom in to look closer at a sample. The Waveform Analysis section (Label 2 in Figure 13), which is located beneath the waveform graph, contains information about the samples taken; the peak-to-peak amplitude, the minimum/maximum amplitude, the mean, the standard deviation of the captured data, and the fundamental frequency of the signal tone are shown.

The waveform graph displays the information for all eight input channels or as many channels as desired. Eight buttons located to the right of the graph, labeled ADC 1 ON/ADC 1 OFF to ADC 8 ON/ADC 8 OFF, selects which channel data displays (Label 1 in Figure 13). An indicator, located to the right of the graph (Label 3 in Figure 13), shows what color graph represents each channel when the data from several channels is displayed.

Data Capture Display

Four tabs display the conversion data in different formats: Waveform, Histogram, FFT, and Summary.

The tools shown in Figure 12 allow user control of the different chart displays within the four tabs.

---

Figure 12. Chart Tools

---

Figure 13. Waveform Tab
HISTOGRAM TAB

Figure 14 shows the Histogram tab. To perform a histogram test, select the Histogram tab in the AD7606 Evaluation Software main window and click the Sample button or Continuous button. A histogram requires a quality signal source applied to at least one of the inputs (V1 to V8).

The Histogram tab displays a histogram of the captured ADC codes. It can give an indication of the performance of the ADC in response to dc inputs. The Histogram Analysis section contains information about the samples taken, for example, the maximum and minimum codes captured.

Figure 14. Histogram Tab
AC TESTING—FFT CAPTURE

Figure 15 shows the FFT tab. The FFT tab analyzes the performance of an ADC in the frequency domain. The FFT tab tests the traditional ac characteristics of the converter and displays a fast Fourier transform (FFT) of the results. The FFT tab shows a plot of the computed FFT data.

The Spectrum Analysis pane contains further information about the analysis, such as the calculated values of signal-to-noise ratio (SNR), signal-to-noise-and-distortion (SINAD), and total harmonic distortion (THD) (see Figure 15).

The user can choose to display the information for one, several, or all eight channels in the FFT tab using the ADC 1 ON/ADC 1 OFF to ADC 8 ON/ADC 8 OFF buttons.

Figure 15. FFT Tab
SUMMARY TAB

Figure 16 shows the Summary tab. This tab captures and displays all three of the plots from the Waveform, Histogram, and FFT tabs in one pane with a synopsis of the information, as well as some of the key performance parameters, such as SNR, THD, S/N +D, and Dynamic Range (see Label 1 in Figure 16).

![Figure 16. Summary Tab]
SAVING FILES

The AD7606 evaluation software can save the captured data for future analysis. The software can capture the current plot images and the current device configuration, as well as the raw waveform data, histogram data, and ac spectrum data.

Saving Data

To save data, go to the File menu and click Save Data. This action saves the raw data captured as seen in the Waveform tab in TSV format.

SAVING FILES

Saving Plot Images

To save plot images, go to the desired analysis tab, click the File menu, and then click Save As Picture.

The images are saved in JPEG format and do not contain any raw data information. Plots saved as images cannot be loaded back into the evaluation environment.

OPENING FILES

Loading Captured Data

The software can load previously captured data for analysis.

Go to the File menu, click Load Data, and select waveform data previously saved in TSV format. The waveform data is a raw data capture that rebuilds the histogram and ac spectrum analyses when loaded into the evaluation platform.
NOTES

ESD Caution
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees that it will promptly return the Evaluation Board to ADI. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOSSES OF PROFITS, DELAY COSTS, LOST DATA OR DISTORTION OF DATA. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive law of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

©2015–2016 Analog Devices, Inc. All rights reserved. Trademarks and registered trademarks are the property of their respective owners.

www.analog.com

Rev. A | Page 15 of 15